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Get a Grip! 
In this experiment, you will measure your grip strength. You will see if your grip strength changes 
as you grip an object for a longer time. You will also compare your grip strength with your 
classmates.    

 
OBJECTIVES 
In this experiment, you will 

• Use a LabQuest and a Gas Pressure Sensor to measure your grip strength. 
• See which of your hands has the greater grip strength.   
• Learn what happens to your grip strength as time passes. 
• Compare your grip strength with your classmates. 

 
 
MATERIALS 

LabQuest  Gas Pressure Sensor Bulb 
LabQuest App Stopper Stem (tapered valve connector) 
Vernier Gas Pressure Sensor heavy-wall plastic tubing 

 
 

 
Figure 1 

PROCEDURE 
1. Squeeze the Gas Pressure Sensor Bulb in your hand. Listen to each end of the bulb to 

determine which end allows air to flow in and out.  

2. Insert the Stem Stopper into the end that allows air flow. Connect the Gas Pressure Sensor 
Bulb/Stem Stopper combination to the plastic tubing. Connect the tubing to the Gas Pressure 
Sensor, as shown in Figure 1. 
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3. Connect the Gas Pressure Sensor to LabQuest and choose New from the File menu. 

4. On the Meter screen, tap Rate. Change the data-collection rate to 10 samples/second and the 
Duration to 60 seconds. 

5. Grip the bulb as hard as you can with one hand, then start data collection. Keep gripping as 
hard as you can. Do not lean your hand or arm on anything. Look away from the screen. 

6. Determine and record your 0–60 s grip average. 
a. Choose Statistics from the Analyze menu. 
b. Record the mean (average) pressure (in kPa) for the 60 second period in your data table. 
c. Choose Statistics from the Analyze menu to turn off statistics. 

 
7. Determine and record your 0–10 s grip average. 

a. Tap and drag your stylus across the first 10 seconds of data to select the data. 
b. Choose Statistics from the Analyze menu. 
c. Record the mean (average) pressure (in kPa) for the 0–10 second period in your data table. 
d. Choose Statistics from the Analyze menu to turn off statistics. 

 
8. Determine and record your 50–60 s grip average. 

a. Tap and drag across the last 10 seconds of data (from 50 to 60 seconds) to select the data. 
b. Choose Statistics from the Analyze menu. 
c. Record the mean (average) pressure (in kPa) for the 50–60 second period in your data 

table.  
 
9. Reset the experimental setup by disconnecting the Gas Pressure Sensor Bulb from the Stem 

Stopper and then reconnecting it. 

 10. Choose New from the File menu and repeat Steps 4–8 using your other hand. 

 
DATA 

Your Results 

 Left hand Right hand 

0–60 s Grip average (kPa)   

0–10 s Grip average (kPa)   

50–60 s Grip average (kPa)   

Difference between 0–10 s avg. and 50–60 s avg.   
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Group and Class Results 

Name Strong hand average 
for 0–60 s (kPa) 

  

  

  

  

Group average  

Class average  
 
 
PROCESSING THE DATA 
1. In the space provided in the data table, subtract to find the difference between your 0–10 s 

average and your 50–60 s average for each hand.   

2. Record the 0–60 s results for the other students in your group. Calculate and record your 
group average. Calculate and record the class average for 0–60 s.   

3. Which of your hands is stronger? Explain your decision.   

4. Did your grip strength increase or decrease during the 60 s period? Why did it change?   

5. How does your grip strength compare with the class average?   

6. What did you learn about your grip strength in this experiment? Were you surprised?   

 
EXTENSION 
1. See if you can increase your grip strength with practice. 





Biology with Vernier ©Vernier Software & Technology 1 

  Graphical Analysis 11 

Cell Respiration 
(CO2 Gas Sensor) 

Cell respiration refers to the process of converting the chemical energy of organic molecules into 
a form immediately usable by organisms. Glucose may be oxidized completely if sufficient 
oxygen is available by the following equation: 

C6H12O6 + 6 O2(g) → 6 H2O + 6 CO2(g) + energy 

All organisms, including plants and animals, oxidize glucose for energy. Often, this energy is 
used to convert ADP and phosphate into ATP. It is known that peas undergo cell respiration 
during germination. Do peas undergo cell respiration before germination? The results of this 
experiment will verify that germinating peas do respire. Using your collected data, you will be 
able to answer the question concerning respiration and non-germinating peas. 

Using the CO2 Gas Sensor, you will monitor the carbon dioxide produced by peas during cell 
respiration. Both germinating and non-germinating peas will be tested. Additionally, cell 
respiration of germinating peas at two different temperatures will be tested.  

OBJECTIVES 
• Use a CO2 Gas Sensor to measure concentrations of carbon dioxide. 
• Study the effect of temperature on cell respiration. 
• Determine whether germinating and non-germinating peas respire. 
• Compare the rates of cell respiration in germinating and non- germinating peas. 

 

Figure 1    
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MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct CO2 Gas  
250 mL respiration chamber 
25 germinating peas 
25 non-germinating peas 
ice water 
thermometer 
100 mL beaker 
paper towels 
goggles 

PROCEDURE 
1. Launch Graphical Analysis. Connect the CO2 Gas Sensor to your Chromebook, computer, or 

mobile device. 

2. Set up the data-collection mode. 

a. Click or tap Mode to open Data Collection Settings. 
b. Change End Collection to 300 s. Click or tap Done. 

3. Measure the room temperature using a thermometer and record the temperature in Table 1. 

4. Obtain 25 germinating peas and blot them dry between two pieces of paper towel.  

5. Place the germinating peas into the respiration chamber. 

6. Place the shaft of the CO2 Gas Sensor in the opening of the respiration chamber. Gently push 
the sensor down into the chamber until it stops. The sensor is designed to seal the chamber 
without the need for unnecessary force. 

7. Wait one minute, then click or tap Collect to start data collection. Data will be collected for 
5 minutes. 

8. When data collection has finished, remove the CO2 Gas Sensor and peas from the respiration 
chamber. Place the peas in a 100 mL beaker filled with cold water and an ice cube. 

9. Use a notebook or notepad to fan air across the openings in the probe shaft of the CO2 Gas 
Sensor for 1 minute.  

10. Fill the respiration chamber with water and then completely empty it to remove residual gas 
from the peas. Thoroughly dry the inside of the respiration chamber with a paper towel.  

11. Perform a linear regression to calculate the rate of respiration. 

a. Click or tap Graph Tools, , and choose Apply Curve Fit. 
b. Select Linear as the curve fit. Click or tap Apply.  
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c. Enter the slope, m, as the rate of respiration in Table 2. 
d. Dismiss the Linear curve fit box.  

12. Obtain 25 non-germinating peas and place them in the respiration chamber. 

13. Repeat Steps 6–11 with non-germinating peas. In Step 8 place the non-germinating peas on a 
paper towel and not in the ice bath. Note: The previous data set is automatically saved.  

Part II  germinating peas, cool temperatures 

14. Remove the peas from the cold water and blot them dry between two paper towels. 

15. Use the thermometer to measure the temperature of the ice water. Record the temperature in 
Table 1. 

16. Repeat Steps 5–11 using the cold peas. In Step 9 place the cold germinating peas on a paper 
towel and not back in the ice bath.  

17. To display multiple data sets on a single graph, click or tap the y-axis label and select the 
data sets you want to display. Dismiss the box to view the graph. Continue to the Analysis 
Questions. 

DATA 
Table 1 

Condition Temperature  
(°C) 

Room   

Ice water   

  

Table 2 

Peas Rate of respiration 
(ppm/s) 

Germinating, room temperature   

Non-germinating, room temperature   

Germinating, cool temperature   
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QUESTIONS 
1. Do you have evidence that cell respiration occurred in peas? Explain. 

2. What is the effect of germination on the rate of cell respiration in peas? 

3. What is the effect of temperature on the rate of cell respiration in peas? 

4. Why do germinating peas undergo cell respiration? 

EXTENSIONS 
1. Compare the respiration rate among various types of seeds. 

2. Compare the respiration rate among seeds that have germinating for different time periods, 
such as 1, 3, and 5 days. 

3. Compare the respiration rates of various small animal types, such as insects or earthworms. 
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Enzyme Action:  
Testing Catalase Activity 

(O2 Gas Sensor) 

Many organisms can decompose hydrogen peroxide (H2O2) enzymatically. Enzymes are globular 
proteins, responsible for most of the chemical activities of living organisms. They act as 
catalysts, substances that speed up chemical reactions without being destroyed or altered during 
the process. Enzymes are extremely efficient and may be used over and over again. One enzyme 
may catalyze thousands of reactions every second. Both the temperature and the pH at which 
enzymes function are extremely important. Most organisms have a preferred temperature range 
in which they survive, and their enzymes typically function best within that temperature range. If 
the environment of the enzyme is too acidic or too basic, the enzyme may irreversibly denature, 
or unravel, until it no longer has the shape necessary for proper functioning. 

H2O2 is toxic to most living organisms. Many organisms are capable of enzymatically breaking 
down the H2O2 before it can do much damage. H2O2 can be converted to oxygen and water, as 
follows: 

2 H2O2 ↔ 2 H2O + O2  

Although this reaction occurs spontaneously, the enzyme catalase increases the rate 
considerably. Catalase is found in most living organisms.  

A great deal can be learned about enzymes by studying the rates of enzyme-catalyzed reactions. 
The rate of a chemical reaction may be studied in a number of ways including: 

• Measuring the rate of appearance of a product 
• Measuring the rate of disappearance of substrate 
• Measuring the pressure of the product as it appears 

In this experiment, you will measure the rate of enzyme activity under various conditions, such 
as different enzyme concentrations, pH values, and temperatures. It is possible to measure the 
concentration of oxygen gas formed as H2O2 is destroyed using an O2 Gas Sensor.  

OBJECTIVES 
•  Measure the production of oxygen gas as hydrogen peroxide is broken down by the 

enzyme catalase or peroxidase at various enzyme concentrations. 
• Measure and compare the initial rates of reaction for this enzyme when different 

concentrations of enzyme react with H2O2. 
• Measure the production of oxygen gas as hydrogen peroxide is broken down by the enzyme 

catalase or peroxidase at various temperatures. 
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• Measure and compare the initial rates of reaction for the enzyme at each temperature. 
• Measure the production of oxygen gas as hydrogen peroxide is broken down by the enzyme 

catalase or peroxidase at various pH values. 
• Measure and compare the initial rates of reaction for the enzyme at each pH value. 

 

Figure 1    

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct O2 Gas  
400 mL beaker 
10 mL graduated cylinder 
250 mL Nalgene bottle 
three Beral pipettes 
3.0% H2O2 
enzyme suspension                 
three 18 × 150 mm test tubes 
ice 
pH buffers 
test tube rack 
thermometer 
goggles 
(optional) Stir Station with magnetic stir bar 

PROCEDURE 
1. Obtain and wear goggles. 

2. Launch Graphical Analysis. Connect the O2 Gas Sensor to your Chromebook, computer, or 
mobile device.  
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3. Set up the data-collection mode. 

a. Click or tap Mode to open Data Collection Settings. 
b. Change Rate to 0.25 samples/s. 
c. Set End Collection to 180 s. Click or tap Done. 

Part I  Effect of enzyme concentration 

4. Place three test tubes in a rack and label them 1, 2, and 3. Fill each test tube with 5 mL of 
3.0% H2O2 and 5 mL of water. 

5. Initiate the enzyme catalyzed reaction. 

a. Using a clean dropper pipette, add 5 drops of enzyme suspension to test tube 1.  
b. Begin timing with a stopwatch or clock.  
c. Cover the opening of the test tube with a finger and gently invert the test tube two times. 
d. Pour the contents of the test tube into a clean 250 mL Nalgene bottle.  
e. Place the O2 Gas Sensor into the bottle as shown in Figure 1. Gently push the sensor 

down into the bottle until it stops. Note: The sensor is designed to seal the bottle with 
minimal force. 

f. When 30 seconds have passed, click or tap Collect to start data collection. 
6. When data collection has finished, remove the O2 gas sensor from the Nalgene bottle. Rinse 

the bottle with water and dry with a paper towel.  

7. Determine the rate of enzyme activity. 

a. Select the data in the most linear region of the graph. 
b. Click or tap Graph Tools, , and choose Apply Curve Fit.  
c. Select Linear as the curve fit. Click or tap Apply. 
d. Record the slope, m, as the reaction rate in Table 2. 
e. Dismiss the Curve Fit box. 

8. Find the rate of enzyme activity for test tubes 2 and 3: 

a. Add 10 drops of enzyme solution to test tube 2. Repeat Steps 5–7. Note: The previous 
data set is automatically saved.  

b. Add 20 drops of enzyme solution to test tube 3. Repeat Steps 5–7. 
9. Display all three runs of data on a single graph. 

a. To display multiple data sets on a single graph, click or tap the y-axis label and select the 
data sets you want to display. Dismiss the box to view the graph. 

b. Use the graph and the data in Table 2 to answer the questions for Part I. 
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Part II  Effect of temperature 

Your teacher will assign a temperature range for your lab group to test. Depending on your 
assigned temperature range, set up your water bath as described below. Place a thermometer in 
your water bath to assist in maintaining the proper temperature. 

• 0–5°C:  400 mL beaker filled with ice and water 
• 20–25°C:  No water bath needed to maintain room temperature 
• 30–35°C:  400 mL beaker filled with warm water 
• 50–55°C:  400 mL beaker filled with hot water 

10. Rinse the three numbered test tubes used for Part I. Fill each test tube with 5 mL of  
3.0% H2O2 and 5 mL of water then place the test tubes in the water bath. The test tubes 
should be in the water bath for 5 minutes before proceeding to Step 11. Record the 
temperature of the water bath, as indicated on the thermometer, in the space provided in 
Table 3. 

11. Find the rate of enzyme activity for test tubes 1, 2, and 3: 

a. Add 10 drops of enzyme solution to test tube 1. Repeat Steps 5–7. Record the reaction 
rate in Table 3. 

b. Add 10 drops of enzyme solution to test tube 2. Repeat Steps 5–7. Record the reaction 
rate in Table 3. 

c. Add 10 drops of enzyme solution to test tube 3. Repeat Steps 5–7. Record the reaction 
rate in Table 3. 

12. Calculate the average rate for the three trials you tested. Record the average in Table 3. 

13. Record the average rate and the temperature of your water bath from Table 3 on the class 
data table. When the entire class has reported their data, record the class data in Table 4.  

Part III  Effect of pH 

14. Place three clean test tubes in a rack and label them pH 4, pH 7, and pH 10. 

15. Add 5 mL of 3% H2O2 and 5 mL of a pH buffer to each test tube, as in Table 1. 

Table 1 

pH of buffer Volume of 3% H2O2 
(mL) 

Volume of buffer 
(mL) 

pH 4 5 5 

pH 7 5 5 

pH 10 5 5 
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16. Find the rate of enzyme activity for test tubes labeled pH 4, pH 7, and pH 10: 

• Add 10 drops of enzyme suspension to test tube pH 4. Repeat Steps 5–7. Record the 
reaction rate in Table 5. 

• Add 10 drops of enzyme suspension to test tube pH 7. Repeat Steps 5–7. Record the 
reaction rate in Table 5. 

• Add 10 drops of enzyme suspension to test tube pH 10. Repeat Steps 5–7. Record the 
reaction rate in Table 5. 

17. Displayed all three runs of data on a single graph. Use the graph and the data in Table 5 to 
answer the questions for Part III.  

DATA 
Part I  Effect of enzyme concentration 

Table 2 

Sample 
Reaction 

rate  
(%/min)  

5 drops   

10 drops   

20 drops   

   

Part II  Effect of temperature 

Table 3 

Sample Reaction rate  
(%/min) 

Trial 1   

Trial 2   

Trial 3   

Average   

Temperature range:  

______________° C 

  

 

  Table 4:  Class Data 

Temperature 
tested 
(°C) 

Average rate 
(%/min) 
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Part III  Effect of pH 

Table 5 

Sample Reaction rate  
(%/min)  

pH 4   

pH 7   

pH 10   

PROCESSING THE DATA 
For Part II of this experiment, make a graph of the rate of enzyme activity vs. temperature in 
Graphical Analysis or by hand. Plot the rate values for the class data in Table 4 on the y-axis and 
the temperature on the x-axis. Use this graph to answer the questions for Part II. 

QUESTIONS 
Part I  Effect of enzyme concentration 

1. How does changing the concentration of enzyme affect the rate of decomposition of H2O2? 

2. What do you think will happen to the rate of reaction if one increases the concentration of 
enzyme to 25 drops? Predict what the rate would be for 30 drops. 

Part II  Effect of temperature 

3. At what temperature is the rate of enzyme activity the highest? Lowest? Explain. 

4. How does changing the temperature affect the rate of enzyme activity? Does this follow a 
pattern you anticipated? 

5. Why might the enzyme activity decrease at very high temperatures? 

Part III  Effect of pH 

6. At what pH is the rate of enzyme activity the highest? Lowest?  

7. How does changing the pH affect the rate of enzyme activity? Does this follow a pattern you 
anticipated? 
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EXTENSIONS 
1. Determine the reaction rates of trials in Part I for each 30 second interval. What patterns do 

you see? What could explain the different rates you determined? 

2. Different organisms often live in very different habitats. Design a series of experiments to 
investigate how different types of organisms might affect the rate of enzyme activity. 
Consider testing a plant, an animal, and a protist. 

3. Presumably, at higher concentrations of H2O2, there is a greater chance that an enzyme 
molecule might collide with H2O2. If so, the concentration of H2O2 might alter the rate of 
oxygen production. Design a series of experiments to investigate how differing 
concentrations of the substrate hydrogen peroxide might affect the rate of enzyme activity. 

4. Design an experiment to determine the effect of boiling the catalase on the rate of reaction. 

5. Explain how environmental factors affect the rate of enzyme-catalyzed reactions. 
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Enzyme Action:  
Testing Catalase Activity 

(O2 Gas Sensor) 

Many organisms can decompose hydrogen peroxide (H2O2) enzymatically. Enzymes are globular 
proteins, responsible for most of the chemical activities of living organisms. They act as 
catalysts, substances that speed up chemical reactions without being destroyed or altered during 
the process. Enzymes are extremely efficient and may be used over and over again. One enzyme 
may catalyze thousands of reactions every second. Both the temperature and the pH at which 
enzymes function are extremely important. Most organisms have a preferred temperature range 
in which they survive, and their enzymes typically function best within that temperature range. If 
the environment of the enzyme is too acidic or too basic, the enzyme may irreversibly denature, 
or unravel, until it no longer has the shape necessary for proper functioning. 

H2O2 is toxic to most living organisms. Many organisms are capable of enzymatically breaking 
down the H2O2 before it can do much damage. H2O2 can be converted to oxygen and water, as 
follows: 

2 H2O2 ↔ 2 H2O + O2  

Although this reaction occurs spontaneously, the enzyme catalase increases the rate 
considerably. Catalase is found in most living organisms.  

A great deal can be learned about enzymes by studying the rates of enzyme-catalyzed reactions. 
The rate of a chemical reaction may be studied in a number of ways including: 

• Measuring the rate of appearance of a product 
• Measuring the rate of disappearance of substrate 
• Measuring the pressure of the product as it appears 

In this experiment, you will measure the rate of enzyme activity under various conditions, such 
as different enzyme concentrations, pH values, and temperatures. It is possible to measure the 
concentration of oxygen gas formed as H2O2 is destroyed using an O2 Gas Sensor.  

OBJECTIVES 
•  Measure the production of oxygen gas as hydrogen peroxide is broken down by the 

enzyme catalase or peroxidase at various enzyme concentrations. 
• Measure and compare the initial rates of reaction for this enzyme when different 

concentrations of enzyme react with H2O2. 
• Measure the production of oxygen gas as hydrogen peroxide is broken down by the enzyme 

catalase or peroxidase at various temperatures. 
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• Measure and compare the initial rates of reaction for the enzyme at each temperature. 
• Measure the production of oxygen gas as hydrogen peroxide is broken down by the enzyme 

catalase or peroxidase at various pH values. 
• Measure and compare the initial rates of reaction for the enzyme at each pH value. 

 

Figure 1    

MATERIALS 
LabQuest 
LabQuest App 
O2 Gas Sensor 
400 mL beaker 
10 mL graduated cylinder 
250 mL Nalgene bottle 
three Beral pipettes 
3.0% H2O2 
enzyme suspension                 
three 18 × 150 mm test tubes 
ice 
pH buffers 
test tube rack 
thermometer 
goggles 
(optional) Stir Station with magnetic stir bar 
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PROCEDURE 
1. Obtain and wear goggles. 

2. Connect the O2 Gas Sensor to LabQuest and choose New from the File menu. 

3. On the Meter screen, tap Rate. Change the data-collection rate to 0.25 samples/second and 
the data-collection duration to 180 seconds. 

Part I  Effect of enzyme concentration 

4. Place three test tubes in a rack and label them 1, 2, and 3. Fill each test tube with 5 mL of 
3.0% H2O2 and 5 mL of water. 

5. Initiate the enzyme catalyzed reaction. 

a. Using a clean dropper pipette, add 5 drops of enzyme suspension to test tube 1.  
b. Begin timing with a stopwatch or clock.  
c. Cover the opening of the test tube with a finger and gently invert the test tube two times. 
d. Pour the contents of the test tube into a clean 250 mL Nalgene bottle.  
e. Place the O2 Gas Sensor into the bottle as shown in Figure 1. Gently push the sensor 

down into the bottle until it stops. Note: The sensor is designed to seal the bottle with 
minimal force. 

f. When 30 seconds have passed, start data collection. 
6. When data collection has finished, remove the O2 gas sensor from the Nalgene bottle. Rinse 

the bottle with water and dry with a paper towel.  

7. Determine the rate of enzyme activity. 

a. Tap and drag your stylus across the most linear region of the graph to select these data 
points.  

b. Choose Curve Fit from the Analyze menu. 
c. Select Linear for the Fit Equation. 
d. Record the slope, m, as the reaction rate in Table 2.  
e. Select OK. 

8. Store the data from the first run by tapping the File Cabinet icon. 

9. Find the rate of enzyme activity for test tubes 2 and 3: 

a. Add 10 drops of enzyme solution to test tube 2. Repeat Steps 5–8. 
b. Add 20 drops of enzyme solution to test tube 3. Repeat Steps 5–7. 

10. Display all three runs of data on a single graph. 

a. Tap Run 3, and select All Runs. All three runs will now be displayed on the same graph 
axes.  

b. Use the graph and the data in Table 2 to answer the questions for Part I. 
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Part II  Effect of temperature 

Your teacher will assign a temperature range for your lab group to test. Depending on your 
assigned temperature range, set up your water bath as described below. Place a thermometer in 
your water bath to assist in maintaining the proper temperature. 

• 0–5°C:  400 mL beaker filled with ice and water 
• 20–25°C:  No water bath needed to maintain room temperature 
• 30–35°C:  400 mL beaker filled with warm water 
• 50–55°C:  400 mL beaker filled with hot water 

11. Rinse the three numbered test tubes used for Part I. Fill each test tube with 5 mL of  
3.0% H2O2 and 5 mL of water then place the test tubes in the water bath. The test tubes 
should be in the water bath for 5 minutes before proceeding to Step 14. Record the 
temperature of the water bath, as indicated on the thermometer, in the space provided in 
Table 3. 

12. Tap Table. Choose Clear All Data from the Table menu. 

13. Tap Graph to display the graph. 

14. Find the rate of enzyme activity for test tubes 1, 2, and 3: 

• Add 10 drops of enzyme solution to test tube 1. Repeat Steps 5–8. Record the reaction 
rate in Table 3. 

• Add 10 drops of enzyme solution to test tube 2. Repeat Steps 5–8. Record the reaction 
rate in Table 3. 

• Add 10 drops of enzyme solution to test tube 3. Repeat Steps 5–7. Record the reaction 
rate in Table 3. 

15. Calculate the average rate for the three trials you tested. Record the average in Table 3. 

16. Record the average rate and the temperature of your water bath from Table 3 on the class 
data table. When the entire class has reported their data, record the class data in Table 4.  

Part III  Effect of pH 

17. Place three clean test tubes in a rack and label them pH 4, pH 7, and pH 10. 

18. Add 5 mL of 3% H2O2 and 5 mL of a pH buffer to each test tube, as in Table 1. 

Table 1 

pH of buffer Volume of 3% H2O2 
(mL) 

Volume of buffer 
(mL) 

pH 4 5 5 

pH 7 5 5 

pH 10 5 5 

19. Tap Table. Choose Clear All Data from the Table menu. 
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20. Tap Graph to display the graph. 

21. Find the rate of enzyme activity for test tubes labeled pH 4, pH 7, and pH 10: 

• Add 10 drops of enzyme solution to test tube pH 4. Repeat Steps 5–8. Record the reaction 
rate in Table 5. 

• Add 10 drops of enzyme solution to test tube pH 7. Repeat Steps 5–8. Record the reaction 
rate in Table 5. 

• Add 10 drops of enzyme solution to test tube pH 10. Repeat Steps 5–7. Record the 
reaction rate in Table 5. 

22. Observe all three runs of data on a single graph. 

a. Tap Run 3 and select All Runs. All three runs will now be displayed on the same graph 
axes.  

b. Use the displayed graph and the data in Table 5 to answer the questions for Part III.  

DATA 
Part I  Effect of enzyme concentration 

Table 2 

Sample 
Reaction 

rate  
(%/min)  

5 drops   

10 drops   

20 drops   
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Part II  Effect of temperature 

Table 3 

Sample Reaction rate  
(%/min) 

Trial 1   

Trial 2   

Trial 3   

Average   

Temperature range:  

______________° C 

  

 

  Table 4:  Class Data 

Temperature 
tested 
(°C) 

Average rate 
(%/min) 

    

    

    

    

    

    

    

    

    
 

Part III  Effect of pH 

Table 5 

Sample Reaction rate  
(%/min)  

pH 4   

pH 7   

pH 10   

PROCESSING THE DATA 
For Part II of this experiment, make a graph of the rate of enzyme activity vs. temperature in 
Graphical Analysis or by hand. Plot the rate values for the class data in Table 4 on the y-axis and 
the temperature on the x-axis. Use this graph to answer the questions for Part II. 

QUESTIONS 
Part I  Effect of enzyme concentration 

1. How does changing the concentration of enzyme affect the rate of decomposition of H2O2? 

2. What do you think will happen to the rate of reaction if one increases the concentration of 
enzyme to 25 drops? Predict what the rate would be for 30 drops. 
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Part II  Effect of temperature 

3. At what temperature is the rate of enzyme activity the highest? Lowest? Explain. 

4. How does changing the temperature affect the rate of enzyme activity? Does this follow a 
pattern you anticipated? 

5. Why might the enzyme activity decrease at very high temperatures? 

Part III  Effect of pH 

6. At what pH is the rate of enzyme activity the highest? Lowest?  

7. How does changing the pH affect the rate of enzyme activity? Does this follow a pattern you 
anticipated? 

EXTENSIONS 
1. Determine the reaction rates of trials in Part I for each 30 second interval. What patterns do 

you see? What could explain the different rates you determined? 

2. Different organisms often live in very different habitats. Design a series of experiments to 
investigate how different types of organisms might affect the rate of enzyme activity. 
Consider testing a plant, an animal, and a protist. 

3. Presumably, at higher concentrations of H2O2, there is a greater chance that an enzyme 
molecule might collide with H2O2. If so, the concentration of H2O2 might alter the rate of 
oxygen production. Design a series of experiments to investigate how differing 
concentrations of the substrate hydrogen peroxide might affect the rate of enzyme activity. 

4. Design an experiment to determine the effect of boiling the catalase on the rate of reaction. 

5. Explain how environmental factors affect the rate of enzyme-catalyzed reactions. 
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Monitoring EKG 
An electrocardiogram, or EKG, is a graphical recording of the electrical events occurring within 
the heart. A typical EKG tracing consists of five identifiable deflections. Each deflection is noted 
by one of the letters P, Q, R, S, or T. The P wave is the first waveform in a tracing and represents 
the depolarization of the heart’s atria. The next waveform is a complex and consists of the Q, R, 
and S deflection. The QRS complex represents the depolarization of the heart’s ventricles. The 
deflection that represents the repolarization of the atria is usually undetectable because of the 
intensity of the QRS waveform. The final waveform is the T wave and it represents the 
repolarization of the ventricles. 

Because an EKG is a recording of the heart’s electrical events, it is valuable in diagnosing 
diseases or ailments that damage the conductive abilities of the heart muscle. When cardiac 
muscle cells are damaged or destroyed, they are no longer able to conduct the electrical impulses 
that flow through them. This causes the electrical signal to terminate at the damaged tissue or 
directed away from the signal flow. The termination or redirection of the electrical signal will 
alter the manner in which the heart contracts. A cardiologist can look at a patient’s 
electrocardiogram and determine the presence of damaged cardiac muscle based on the 
waveform as well as the time interval between electrical events. 

In this activity, you will use the EKG sensor to make a five-second graphical recording of your 
heart's electrical events. From this recording, you will identify the previously mentioned 
waveform components and determine the time intervals associated with each. 

 

Figure 1    

OBJECTIVES 
• Use the EKG Sensor to graph your heart’s electrical activity. 
• Determine the time interval between EKG events. 
• Calculate heart rate based on your EKG recording. 
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MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct EKG  
disposable electrode tabs 

  

 

Figure 2    

PROCEDURE 
1. Launch Graphical Analysis. Connect the EKG Sensor to your Chromebook, computer, or 

mobile device. 

2. Click or tap Mode to open Data Collection Settings. Change End Collection to 5 s. Click or 
tap Done. 

3. Attach three electrode tabs to your arms, as shown in Figure 2. A single tab should be placed 
on the inside of the right wrist, on the inside of the right upper forearm (below elbow), and 
on the inside of the left upper forearm (below elbow). 

4. Connect the three sensor leads to the electrode tabs as shown in Figure 2. Sit in a reclined 
position in a chair or lay flat on top of a lab table. Your arms should be hanging at the side 
unsupported.  

5. Another member of the lab group should click or tap Collect to start data collection. 

6. Once data have been collected, a graph with voltage and time values will be displayed. Click 
or tap the graph to examine the data. Note: You can also adjust the Examine line by dragging 
the line. 

7. For at least two heartbeats, identify the various EKG waveforms using Figure 1 and 
determine the time intervals listed below.  

8. Record the average for each set of time intervals in Table 2. 
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Table 1 

Waveform Time interval 

P-R interval Time from the beginning of P wave to the start of the QRS 
complex 

QRS complex Time from Q deflection to S deflection 

Q-T interval Time from Q deflection to the end of the T 

  

9. Calculate the heart rate in beats/min using the EKG data. Remember to include the time 
between the end of the T Wave and the beginning of the next P Wave. Use the total number 
of seconds for one full heart cycle in the equation. Record the heart rate in Table 2. 

 

10. If your EKG was unsatisfactory, repeat Steps 4–6. 

11. (optional) Print a copy of your EKG graph. Identify and label the various waveforms on the 
graph.  

DATA 
Table 2 

Interval Time (s) 

P - R   

QRS   

Q - T   

Heart rate: ___________ beats/min 

  QUESTIONS 

1. The electrocardiogram is a powerful tool used to diagnose certain types of heart disease. 
Why is it important to look at the time intervals of the different waveforms? 

2. What property of heart muscle must be altered for an EKG to detect a problem? Explain. 

3. Based on what you have learned regarding electrocardiograms, can they be used to diagnose 
all heart diseases or defects? Explain. 

4. Describe a cardiovascular problem that could be diagnosed by a cardiologist using an 
electrocardiogram. 
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EXTENSION 
Using data collected with the EKG Sensor, it is possible to determine a more accurate maximum 
heart rate value for a person. The commonly used formula for calculating maximum heart rate is: 

220 bpm – Individual’s Age = Max Heart Rate 

While this formula is sufficient for general purposes, it fails to take into account physical 
differences such as size, and fitness level. For example, an individual that engages in regular 
exercise will likely have a heart that operates more efficiently due to the effects of athletic 
training.  

To calculate your maximum heart rate, do the following: 

a. Run in place or perform some type of exercise, such as jump-n-jacks, for 1-minute. 
b. Repeat Steps 1–8 to collect and analyze your electrocardiogram. When analyzing the data 

in Step 8, only determine the average Q-T interval. 
c. Divide 60 seconds by the Q-T interval to calculate your maximum heart rate. 



Digital Microscope Imaging Options from Vernier 

 
 

Product Name Order Code (Price) Device 
Compatibility Use 

Celestron Digital 
Microscope Imager 

(2 Megapixel) 

CS-DMI ($79) Computer 
Chromebook 
LabQuest 2 

 Existing 
Microscopes 

 Replaces an 
eyepiece 
 

Celestron Digital 
Microscope Imager 

(5 Megapixel) 

CS-5MP ($99) Computer 
Chromebook 
LabQuest 2 

 Existing 
Microscopes 

 Replaces an 
eyepiece 
 

USB Digital 
Microscope 

BD-EDU-100 ($119) Computer 
Chromebook 
LabQuest 2 

 Stand alone 
 Independent light 

source 

ProScope Micro 
Mobile Microscope 

BD-PMM ($149) iPad 
iPhone 

iPod Touch 
Galaxy S4 

 Uses imaging apps 
on mobile device 

 Independent light 
source 

 Different sleeve for 
each device 

ProScope 5MP 
Microscope Camera 

BD-PS-MC5UW ($299) Computer 
Chromebook 
iOS Devices 

Android Devices 

 Existing 
Microscopes 

 Replaces an 
eyepiece 

 Connects to iOS 
and Android 
devices via Wi-Fi 

 Connects to 
computers and 
Chromebooks via 
USB 
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